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Module Overview
This module takes a fundamental approach to a ControlLogix system. It begins with an
overview of the architecture and migrates into an introduction of RSLogix 5000, the
programming environment. Students will learn how to setup communications to the
PLC using RSLinx, download and upload projects, as well as determine the modes of
the CPU.

Included Lessons
Lesson 1 - System Overview --------------------------------------- 3
Lesson 2 - RSLogix/Studio 5000 Overview ---------------------- 21
Lesson 3 - RSLinx ----------------------------------------------------- 37
Lesson 4 - Configuring Ethernet Modules ---------------------- 47
Lesson 5 - CPU Modes ----------------------------------------------- 53
Lesson 6 - Downloading/Uploading ------------------------------ 57

AB_CLX_Standard_4_Day_Module1_5F.docx

Module 1 Overview

Lesson Design
Most lessons include the following sections:
Lesson Objectives: The main objectives or what the lesson, the instructor and the
student will accomplish throughout the lesson.
Terminology: Most lessons have a glossary of important terms, which will be needed
to understand concepts within the lesson.
The Main Lesson Body: Although this section does not have a header this is the main
portion of the lesson, covering the required material.
Exercise: Gives the student the opportunity for hands-on practical experience.
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ControlLogix

System Overview

Lesson Objectives
This lesson is designed to introduce the student to the hardware and system
components used in a typical ControlLogix system. The following hardware topics and
components are covered in this lesson:
❑
❑
❑
❑
❑
❑
❑
❑
❑

System Overview
Chassis & the ControlBus Backplane
Power Supplies
Logix 5000 Processors
CompactLogix Processors
Discrete and Analog I/O
Communication Bridge Modules
Motion Control Modules
Software Overview

Terminology
Tag

A text based address

RTB

Removable Terminal Block, or the harness that plugs into most
modules that interface with field devices

RIUP

Remove and Insert Under Power. All ControlLogix modules can be
inserted or removed with power applied to the chassis.

DLR

Dual Level Ring, the term used to describe building an EtherNet/IP
network as a ring.
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System Overview

Logix 5000 System Overview
The Logix 5000 architecture was designed to provide a single platform to cover the
needs of many applications. Typical applications include the following:
• Sequential or traditional PLC control
• Modular communications including Gateway functionality
• Process control or traditional DCS control
• Drive System and Motion Control
The Logix 5000 platforms are known as a PAC, or Programmable Automation
Controller. PAC is a “super” PLC or Programmable Logic Controller. These systems
include the following features:
• Projects downloaded to the processor include configuration, logic, tags and
data
• Very fast CPU processing for more advanced control algorithms
• Large memory capacities
• True multitasking with multiple processors in the chassis
• Pre-emptive multitasking within each processor
• Chassis are modular allowing placement of modules, including the processor, in
any slot
The Logix 5000 systems include ControlLogix, CompactLogix, GuardLogix, DriveLogix
and SoftLogix.

ControlLogix is Allen Bradley’s top of the line
controller for high speed and multidiscipline control.
Much of what
you learn in the
ControlLogix
course is
applicable to all
platforms.

CompactLogix is a rackless based system for small to
mid-sized machine-level control applications

GuardLogix is a safety rated processor used with
ControlLogix hardware. The internal hardware in a
safety PLC is redundant and performs diagnostics to
ensure the performance of the safety function.

DriveLogix is a PowerFlex drive with an embedded Logix processor. SoftLogix is a virtual
PLC running on a computer.
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Processors
At the heart of a ControlLogix or CompactLogix system are the controllers, features
include:
• Text based addressing called tags instead of register based as in a SLC-500
• May use produced / consumed tags for controller to controller communications
without ladder logic
• Allows multiple controllers in the chassis, facilitating application load sharing
• Instructions include the full PLC-5 instruction set and a complete set of logic
motion instructions. Block transfer instructions can be performed using a MSG
instruction, but are only required when using legacy remote I/O hardware
• Other programming languages such as:
o Function Block Diagram (FBD)
o Sequential Function Chart (SFC)
o Structured Text (ST)

ControlLogix Processors
Early ControlLogix Processors
•

•
•

1756-L1 – The first ControlLogix processor was 7 times faster than
a comparable PLC5 system. The memory in the processor was
expandable. The last firmware version for this processor is 13
1756-L55 – This processor is 7 times faster than the original L1.
No base memory is included, but memory modules are available
up to 7.5 Mbytes. The last firmware version for this processor is 16

60 Series Processors
•
•
•
•

The 1756-L6x processors are 2-3 times faster than a L55 processor.
The processor memory is fixed, depending on the model the
processor could have from 2 to 32MB of memory.
CompactFlash is used for non-volatile memory
The last firmware version for this series of processors is 20

70 Series Processors
•
•
•
•
•
•

USB communication port
On-board display providing enhanced controller diagnostics and
run-time information
SDRAM for non-volatile memory
Energy storage module eliminates need for battery
Double the amount of controller connections
The processor memory is fixed, depending on the model, the processor can
have from 2 to 32 MB of memory
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80 Series Processors
•
•
•
•

Requires Studio 5000 version 28 or higher
USB communication port
The 80 series processors add gigabit EtherNet ports to the
processor
The processor memory is fixed and depending on the model, the
processor can have from 3 to 40 MB of memory

ControlLogix XT
•
•
•

L73 based controller
designed for extreme environments
it has 8 MB memory

Armor ControlLogix Processors
•

For on machine solutions, there is ControlLogix, GuardLogix, and
CompactLogix versions available

Current ControlLogix Processors
Refer to the
ControlLogix
Selection Guide
(Publication
1756-SG001)
for further
specifications

6
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GuardLogix Processor Features
GuardLogix processors add the ability to create the ESTOP string on a machine using IO
on either DeviceNet, EtherNet/IP or ControlNet. The safety logic is contained in a
periodic task. Variable speed drives and servo system may also have safety related
options for safe limited speed or torque. Depending on the IO hardware used and how
it is configured safety levels up to SIL 3 / PLe can be achieved.
Rockwell products that include safety are usually RED.
GuardLogix controllers can be purchased as an L6xS, L7xS and L8xES processor. The
L7xS and L6xS require a 1756-LSP safety partner. This processor runs only the safety
logic as a redundant check. These processors have all the same features and
capabilities of standard processors. The L8xES series processor can be used without a
safety partner (1756-L8SP) if only SIL 2 / PLd is required. SIL3 / PLe requires the safety
partner to be installed.

Chassis and the ControlBus Backplane
The chassis used in ControlLogix systems come in several different sizes: 4, 7, 10, 13,
and 17 slots. Series A chassis have a 10 amp backplane while the Series B supports 13
amps.
The backplane, which is part of the chassis, is called ControlBus. It operates as a mini
network, fashioned after the communications platform ControlNet.
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Power Supplies
Every chassis requires a power supply that provides
voltage down the backplane to the modules. There
are several different power supplies available.
Refer to the
ControlLogix
Power Supply
Technical Guide
(Publication
1756-TD005)
for further
specifications

Standard AC Power Supplies
Standard DC Power Supplies
XT Power Supplies
Redundant Power Supplies

1756-PA50 (Slim), 1756-PA72, 1756-PA75/B
1756-PB50(Slim), 1756-PB72/C, 1756-PB75/B,
1756-PC75/B, 1756-PH75/B
1756-PA30XT (Slim), 1756-PB30XT(Slim), 1756PAXT, 1756-PBXT
1756-PA75R/A, 1756-PAXTR, 1756-PB75R/A,
1756-PBXTR

There are also cables specific to redundant power supply installations, check the user
manuals for more information.

RIUP
RIUP, or Remove and Insert Under Power is a feature
of the ControlLogix system that allows modules to be
removed from the chassis without powering down.
From a hardware perspective, looking at the card
edge; the connector shows two different sizes of pins.
As the card is removed from the chassis the shorter
pins, or the data lines are broken first; then the
longer ones, the supply pins are disconnected. From a software perspective, RIUP is
accomplished during the maintenance portion of the processor scan.

Warnings:
1) Removing modules while power is applied to the chassis may cause arcing. This
may cause a safety concern in some environments.
2) If you remove a module required to control your process or machine – will it
run properly?

8
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Discrete/Digital I/O Modules
Discrete/Digital input modules read if a voltage is present or not
for such things as buttons and switches. Discrete/Digital output
modules turn terminals on or off to control devices such as lights
and relays. These modules are available in a variety of
configurations:
• AC and DC versions
• 8, 16, and 32 point densities
• Non-isolated, and individually isolated modules
• Diagnostics modules
• Electronic fusing
• Electronic keying
Diagnostic modules include:
• Electronic fusing on output cards
• Open wire detection on input cards
• No load and output verification on output modules
Diagnostics features (if available) can be configured on a per-terminal basis.
Diagnostic bits can be latched on to trap intermittent faults. The latched diagnostic bits
can be reset online, by the user, or by using a message instruction. Open wire
diagnostics detection may require a resistor installed across field devices.
The wiring diagram below shows how an input module is wired.
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Analog I/O Modules
Analog input modules handle DC voltages (e.g. 0-10V) or current signals (4-20mA) from
such devices as pressure transducers or flow meters. Analog output modules convert
digital values into signals for instruments like a flow controller or valve positioner.
Features of Analog I/O cards include:
• Current and/or voltage capabilities
• Onboard scaling to engineering units
• Alarming on input modules
• Output clamping on output modules
• Integer or floating point data formats
Typical wiring for current or voltage inputs is shown below:

10
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Catalog Numbers
A catalog number for an I/O module has the following format:
Bulletin (1756=ControlLogix, 1769=CompactLogix)
Type (I=Input, O=Output)
Electrical Spec (A=120 VAC, B=24VDC, F=Analog)
Number of Points/Channels

Options (D=Diagnostics, E=Electronic Fuse, I=Isolated)
Series

1756-OB16D/A

Removable Terminal Blocks
Most discrete and analog I/O modules use RTBs, or Removable Terminal Blocks. Field
devices are wired to the RTB, not the module, making it easier to swap out a faulty
module. There are two pieces to an RTB, the terminal strip and the shroud. The shroud
can be removed from the RTB to expose the terminal strip.

Each module equipped with an RTB has a plastic locking clip that can be set to one of
two positions. In the up position, next to the picture of the open padlock the RTB can
be removed without pulling the I/O module out of the chassis. In the down position,
next to the picture of the closed padlock, pulling on the swing arm will pull the entire
module out. Be sure to examine the locking clip before removing a swing arm.

© Automation Training - 2021
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RTBs are not
included with
modules
because they
come in two
main versions,
screw clamp
and spring
clamp. Spring
clamp versions
are suggested
for high
vibration
environments.
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Communication Bridge Modules
Any
communication
card can be
used to
communicate to
the processor
for
downloading,
uploading and
monitoring.

Communication is no longer the responsibility of the
processor module. This has been off loaded to communication
modules. These modules are dedicated to a specific network
protocol. The following network communication cards are
available:
• DH+/RIO modules for legacy networks
• CNB modules for ControlNet
• DNB modules for DeviceNet
• EtherNet/IP modules
The name bridge module is actually fairly descriptive. These
modules can provide a bridging or gateway function, which
allows communications to bridge, or jump from one network
to another without processor intervention.

Motion Control Modules
There are numerous motion control modules in the ControlLogix family:
• 1756–MO2AE, 2 Axis Analog Module
• 1756–MO3SE, 3 Axis Sercos Module
• 1756–MO8SE, 8 Axis Sercos Module
• 1756–MO16SE, 16 Axis Sercos Module
• Motion is also possible over EtherNet/IP starting at firmware version 21 (Studio
5000)
There are other modules available to include hydraulic motion. Motion is programmed
with ladder instructions; no additional software is required in a motion system.

12
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CompactLogix Hardware
The CompactLogix series of processors covers from small to mid-sized applications.
They are typically meant to be used at the machine level.
Refer to the
CompactLogix
Selection Guide
(1769-SG001NEN-P) and the
Technical
Manual (1769TD005) for
more detailed
specifications

There are more controller choices for CompactLogix than there are for ControlLogix.
Current selections include:
5370-L1 systems include EtherNet/IP ports, USB port and support for local expansion
modules. The local expansion is via 1734 POINT IO family IO modules.

Characteristic
User Memory
Communication Ports
Ethernet/IP Connections
Integrated Motion Axes
Module Expansion

1769-L16ER
384 KB
4
6 1734 Modules

© Automation Training - 2021

1769-L18ER
1769-L18ERM
512 KB
512 KB
2 Ethernet, 1 USB
8
8
2
8 1734 Modules 8 1734 Modules

1769-L19ER
1 MB
8
8 1734 Modules
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System Overview
5370-L2 systems include EtherNet/IP ports, USB port and support for local expansion
modules. The local expansion is via 1769 family IO modules. The modules are placed to
the right of the CPU and an end cap must be installed.

Refer to the
CompactLogix
Selection Guide
(1769-SG001NEN-P) and the
Technical Specs
(1769-TD005)
for more
detailed
specifications

14
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5370-L3 systems offer local expansion installed in up to three banks of modules. The
modules may be arranged horizontally or vertically. 1769 IO modules are used with
these controllers. The number of allowable local IO module varies with the controller
used.

Standard 1756-L3 Processors
Characteristic
User Memory
Safety Memory
Communication
Ports
Ethernet/IP
Connections
Integrated Motion
Axes
Module Expansion

1769-L30ER(M)(NSE)(S)
1 MB
500 KB (S)

1769-L33ER(M)(S)

1769-L36ER(M)(S)

1769-L37ER(M)(S)

1756-L38ER(M)(S)

2 MB
1 MB (S)

3 MB
1.5 MB (S)
2 Ethernet, 1 USB

4 MB
1.5 MB (S)

5 MB
1.5 MB (S)

16

32

48

64

80

4 (M)

8 (M)

16 (M)

16 (M)

16 (M)

8 1769 Modules

16 1769 Modules

30 1769 Modules

31 1769 Modules

31 1769 Modules

There are GuardLogix versions of the 5370-L3 processors as well. A second processor
or safety partner is not needed.
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Refer to the
CompactLogix
Selection Guide
(1769-SG001NEN-P) and the
Technical Specs
(1769-TD005)
for more
detailed
specifications
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5380 Controllers
These controllers are meant for mid-sized applications requiring high speed
communications and up to 32 axis of motion control.
Catalog Number

User Memory

Safety Memory

Ethernet/IP Nodes

5069-L306ER(M)(S2)
5069-L310ER(M)(S2)
5069-L320ER(M)(S2)
5069-L330ER(M)(S2)
5069-L340ER(M)(S2)
5069-L350ERM(S2)
5069-L380ERM(S2)
5069-L3100ERM(S2)

0.6 MB
1 MB
2 MB
3 MB
4 MB
5 MB
8 MB
10 MB

0.3 MB (S2)
0.5 MB (S2)
1 MB (S2)
1.5 MB (S2)
2 MB (S2)
2.5 MB (S2)
4 MB (S2)
5 MB (S2)

16
24
40
50 / 60 v31
55 / 90 v31
60 / 120 v31
70 / 150 v31
80 / 180 v31

Integrated
Motion Axes
2
4
8
16
20
24
28
32

I/O Expansion
8
8
16
16 (31 >v29)
31
31
31
31

5480 Controllers
This controller also contains a windows 10 IOT (Internet of Things)
desktop. It has direct access to the standard Logix processor.
• Ideal for mid-size to large applications requiring high
performance control and data throughput
• Enables high-speed I/O, motion control, and Device Level
Ring/Linear topologies
• Includes three GbE Ethernet/IP ports that enable highspeed communications, I/O, and motion control (two are configurable, and
support Dual IP address or Device Level Ring)
• Includes one GbE Ethernet port as a dedicated commercial OS network
interface
• Supports up to 31 local 5069 Compact I/O modules

CompactLogix Additional Capabilities
If the model name of the processor includes an “M” such as L18ERM, the processor can
use EtherNet/IP based motion. The number of axis supported will vary per the
processor specifications.
If the model name of the processor includes an “R” such as L18ER, the processor
supports DLR
There are safety versions of some of the CompactLogix processors, just like the
ControlLogix processor, there will be a ‘S’ in the model name.

16
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Software Packages
To program, configure, and maintain a ControlLogix system you will need the following
software packages:
• RSLogix 5000 / Studio 5000 – The main programming and configuration
package. With release of version 21, RSLogix was renamed to Studio 5000 Logix
Designer. There are different bundles of this software: Standard, Professional,
Full, Lite, Mini and Service which come with different features.
• RSLinx – Communication software
• ControlFlash – Firmware updating tool
• RSNetworx for CNET / DNET – Network configuration package if your system
includes a ControlNet or a DeviceNet network

RSLogix / Studio 5000
RSLogix 5000 is used to create, modify and troubleshoot ControlLogix projects.

There are a number of versions available depending on the hardware platform used
and the programming languages selected.
• Version 10 and later releases includes the Control Flash software package
• Software registration keys are required to run all RSLogix 5000 packages
• Prior to version 10 only one release could be installed on a computer, or more
accurately on a hard drive partition
• Version 10 allows multiple future release installations and one backwards
release installation
• As of version 21, RSLogix 5000 has been renamed Studio 5000

© Automation Training - 2021
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Refer to the
ControlLogix
Selection Guide
(Publication
1756-SG001)
for different
editions and
Windows
compatibility.
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RSLinx
RSLinx is communication software. RSLinx provides a means for software packages
running on a computer to talk via its drivers to nodes on a network.

ControlFlash and Revisions
Each module in the ControlLogix family contains firmware, which is “burned” into the
module using the ControlFlash software package. Upgradeable firmware allows
module designers an extremely fast method to update, change or fix features in a
module. Registered and in support RSLogix users may download firmware from the
internet.
Warning! When flashing the firmware of any module allow the process to complete.
Use a reliable, fast driver to flash modules. (Flashing a processor using the serial port
will take 45 minutes: Flashing via 100 Megabit Ethernet will take 30 seconds)
There are several ways to determine the firmware revision of a module:
• Check the firmware sticker on the side of the module. This method is
unreliable, as it only indicates what revision firmware the module shipped with
at time of purchase
• Use an existing RSLinx driver to access the ControlLogix chassis. Right click on a
module and select Device Properties
• Use any web browser to connect to an existing Ethernet module in the chassis.
ControlLogix Ethernet modules have HTML code built in to the firmware,
allowing users to access hardware information across a network.

RSNetworx for ControlNet / DeviceNet
RSNetworx is available in multiple versions; one for ControlNet and one for DeviceNet.
These are software packages used to build and configure ControlNet and DeviceNet
networks. They are available at an additional cost. There is also a version of RSNetworx
for EtherNet/IP – it is a diagnostic tool only.

18
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HMI Software / Hardware
Rockwell’s HMI offerings are FactoryTalk View ME and SE. The ME package is to
develop applications for PanelView Plus hardware and runtime software. The SE
package is a full SCADA package for large machine / plant monitoring. A screen capture
of the ME display editor is shown below.
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Your Turn # 1 – The Demo
1) Identify the CPU model in your demo unit. ________________
2) Examine the front of the EtherNet/IP module. It should be located in slot 6 of
the chassis. The window on the top of the module will have a number scrolling
across it with a format like 192.168.2.xx This is the IP or Internet Protocol
address that has been assigned to the communications module. Record your IP
address: ___________________________
3) Launch a web browser, and type in the IP address of your demo unit

4) Select Browse Chassis (or Chassis Who for older versions) and double click on
the processor module. What revision is the module? ___________

5) Check the revision level for all the modules and record the correct firmware
_________________________________________________________________
_________________________________________________________________
_________________________________________________________________
_________________________________________________________________
_________________________________________________________________
This can also be done using RSLinx. You will be doing this later in the class.

20
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RSLogix/Studio 5000
Overview

Lesson Objectives
This lesson will introduce you to RSLogix 5000, the programming environment used for
ControlLogix systems. The following topics are covered in this lesson:
❑
❑
❑
❑

Software overview
Menus
Toolbars
RSLogix 5000 configuration

Terminology
Toolbars

A collection of icons that are grouped in line to provide shortcuts
to specific functions.

Tooltips

Tooltips are part of the help structure of any windows program
and are displayed when you position the cursor over a toolbar
icon.

Project

A project is a file created by RSLogix 5000 and saved on the hard
drive of the computer.

Logix
Designer

Starting with release 21 of RSLogix 5000, Rockwell renamed the
RSLogix 5000 as Studio 5000 Logix Designer.
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RSLogix 5000 Overview
RSLogix 5000 software is the main programming environment for the ControlLogix
family of products. RSLogix 5000 is a Windows based software package which complies
with standard Windows conventions, including the following features:
• Drop menus
• Toolbars
• Sub windows
• Tool tips
• Explorer style project organizer
• Drag n’ Drop, Cut – Copy – Paste

22
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Working with Projects
When you first launch a session of RSLogix 5000, the main environment opens without
a project loaded. To open an existing project select Open from the File menu. Keep in
mind that only one project can be running in one session of RSLogix 5000. If your
intention is to cut – copy – paste from another project you must launch a second
session of RSLogix 5000.
To create a new project, select the File > New menu item. This dialog box will appear.

The following attributes must be configured when creating a new project:
Type - Select the part number of the processor you will be using.
Revision - Select the firmware revision of the processor.
Name - This name will be stored in processor memory when you download the project.
It is also used for hard disk operations.
Description - Documentation stored with the project on the hard disk.
Chassis Size - Select the size of chassis you will be using.
Slot - The slot number where the processor will be installed.
Create In - Defines where on the hard disk to store the project.
The default directory for projects created with the RSLogix 5000 software depends on
what operating system is being used. With RSLogix 500 the default is C:\RSLogix 5000\.
With Studio 500 the default is MyDocuments\Studio 500\Projects. The defaults may be
changed under the Tools / Option Menu.
© Automation Training - 2021
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The Quick Start
page was
introduced in
version 16
provided easier
access to
projects and
help files.
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RSLogix 5000 – File Structure
An RSLogix 5000 project can appear on the hard disk with any of the following
extensions:
test.ACD:

This is the main file extension or file type that can be directly
opened with RSLogix 5000. It contains all project databases
including the program logic, data, tags and descriptions.

test.L5K:

ACD files can be saved with the L5K extension using the File >
Save As menu item. L5K files are stored in ASCII and typically
offer a 40 to 1 compression ratio, reducing space required for
file archiving. An L5K file cannot be directly opened by the
RSLogix 5000 software. It must be converted by the software
into ACD format first.

test.L5X:

XML file, may be used to import / export rungs, routines and
tags.

test.SEM:
test.WRK:

SEM and WRK files are created by RSLogix 5000 whenever you
open a project. When you close a project the two files are
deleted, the files are temporary working files. If Windows or
RSLogix 5000 shuts down abnormally, most or all of your work
will be recoverable.

24
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Main Menu
The main menu structure of RSLogix 5000 reveals features that resemble many
Windows based products. For example, every Windows based program has file related
commands to create, open and save projects. Pulling down the File menu in RSLogix
5000 also shows many other File type commands.
These include:
New Component - Allows the
programmer an easy way to add
new components into the
project. The individual selections
will be explained in further
lessons.
Compact - Over time the project
databases will become
fragmented much like the hard
drive of a computer. The
Compact selection will clean up
the database.
Page Setup…
Generate Report…
Print
Print Options…
All components of the project
can be printed in different
formats.
Project Links
A list of the most recently
opened projects.
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Edit Menu
The Edit menu in RSLogix 5000 contains many
features found in standard Windows
applications. These include:
• Undo – Redo
• Cut – Copy – Paste
• Ladder Element Editing
• Select All
• Properties
Most of the items in the Edit pull-down menu are
also accessible using hot keys. For example,
Control-C, Control-X and Control-V can be used
to copy, cut and paste.

View Menu
The View pull down menu can be used to modify
the appearance of RSLogix 5000. The user can
turn Toolbars on or off, customize Toolbars,
Zoom in or out of the Language Editor display
and hide/display the Results window and
Controller Organizer.
RSLogix 5000 allows the user to select which
Toolbars are to be displayed, and allows some
degree of Toolbar customization. Toolbars can be
customized by selecting Toolbars under the View
menu. When you select either the Language
Element or Ladder Common the Customize button will be accessible.

Custom Menus
Several of the menus in RSLogix 5000 are custom menus that include features that are
specifically for RSLogix 5000. These menus will be presented briefly here, as they will
be covered fully in subsequent lessons.
These include:
Search
Logic

26

Search contains the main search engine, allowing the user to find a
variety of data and text throughout the project.
This menu gives the user access to the Tag Database, the Force
function, and several other specialized features of the RSLogix
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RSLogix/Studio 5000 Overview
5000 software. Tools for Online editing are available in this menu,
but most users prefer to use icons that are located on the desktop.
Communications This menu allows users to Go Online to a controller, Upload a
project from a controller into computer RAM, or Download an
open project to a controller. It is important to realize that the
software “remembers” the last controller it was communicating
with, so selecting any of the choices above could result in
undesirable operation. Instead, use the Who Active command to
select a controller.
RSLogix 5000 cannot communicate directly with real-world hardware. It uses RSLinx
software to upload, download or go online. RSLinx should be considered the “conduit”
between most software packages and hardware devices. RSLinx will automatically
launch when any communication request like Who Active is selected.

Tools Menu
The tools menu within RSLogix 5000 contains a combination of many features including
the following:
Options

Allow the user to customize the display.

Security

Security settings can be applied to a project if it is being used in
conjunction with the RSSecurity Server. If you do apply settings while a
project is open this selection will allow you to refresh these settings.

Translate
PLC5 / SLC

RSLogix 5000 has the ability to translate PLC5 and SLC500 projects into
ControlLogix5000 projects. The translation process requires some
intermediate steps.

Import and
Export Tags

This utility allows the user to import or export tags to and from the tag
database. The utility uses the common CSV file format. Once exported,
users can modify tags using third party software such as Microsoft
Excel, and then import the modified tag database back into a project.

Motion
Direct
Commands

This dialog box allows you to directly manipulate the motors of a Sercos
or Analog servo system.

© Automation Training - 2021
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Optional tools can be installed which will be listed at the
bottom. Some of the more common items are:
• ControlFlash – Used to update the firmware.
• BootP-DHCP Server – To assign IP address to
Ethernet devices.
• Compare Tool – For finding the differences
between two projects.

Window Menu
Traditionally the Window menu in most Windows based
products provides a means for the user to easily work
with several open projects. RSLogix 5000 can only open
one project at a time, so the Window menu works a bit
differently.
The top six selections allow manipulation of the various
open windows by lining them up differently on the
screen.
A useful tool under this menu is the Split function, which
allows the user to split the ladder window into two
sections. Unfortunately the split function does not allow
two separate routines to be loaded within the one split
window. To edit between routines load them
into separate sub windows by using New Window and
then tile them.

Help Menu
The Help menu provides on-line help. Releases after16
the help is context sensitive. The standard Windows
Help button is F1, it is a keystroke worth remembering!
Links are also provided for manuals and sample projects.
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Toolbars Included in RSLogix 5000
Standard Toolbar

The standard toolbar is the first toolbar at the top of the screen and includes features
like file operations, searching, and routine verification.
As a general tip, the instruction toolbar can be re-sized by dragging the edge of the
toolbar with your mouse. Be careful how small you re-size this. If re-sized too small the
icons on the toolbar will be hidden and it will be difficult to decipher them.

Online Toolbar

The Online toolbar is similar to the original “Classic Online Toolbar”, which can still be
accessed by selecting Classic Online on the View > Toolbar menu. The Online toolbar
allows users to Go Online, Upload, Download, Enable Forces and check for Online
edits. As a rule, it is safer and more predictable to select Communications, then Who
Active for any communication operations.

Path Toolbar

Originally included with the Online toolbar, the path toolbar provides a reference to
the communications path used by this project. This path is set once a user goes online
to a system. Pulling down the menu arrow at the end of this toolbar allows access to
the list of “past used” paths.

Language Element Toolbar
This instruction toolbar provides easy
access to the ControlLogix instruction
set. Instructions are grouped according
to their particular function. When editing
function block programs this toolbar changes to
the function block instruction set.
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Controller Organizer
The Controller Organizer appears on the left side of an RSLogix 5000 project and is
modeled after Windows Explorer. Any folder with a plus (+) sign contains sub-folders
and can be expanded by clicking on the plus sign. In a similar fashion; folders with a
minus sign (-) can be collapsed by clicking on the minus sign. A stand-alone folder or
icon can be opened using the double-click method.
Each folder gives the user access to a different section of the project. A summary of
some of the more relevant folders is given below:
• Tasks Folder – Contains Tasks, Programs and Routines that are used to break
user entered code into sections
• Motion Groups – Contain configuration information related to motion control
code
• Data Types – Contain predefined, user defined and module defined data types
available or in use by the project
• I/O Configuration - Contains a list of the I/O and Communication modules
being accessed by the controller
The format of the organizer changed slightly at revision 15. The graphic on the left
below shows the organizer at revision 13, the one in the middle is Rev19, the one on
the right is revision 24. In the earlier revisions the local chassis and processor were not
displayed in the I/O configuration. The Studio versions added a Logical view, that does
not display the I/O configuration, just the program structure.
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Main Window
The Main Window serves two purposes. The first is to display a routine for monitoring
and or editing. The second function is to allow access to the tag database.
Each of the views provides several sub-functions. In the case of routines, the window
can show the programming environment for the language being used.
Main Window showing Ladder Logic

NOTE that the
branches
shown on rung
2 were entered
incorrectly.
Can you
describe what
was done
incorrectly?

Open Routine Tabs

V31 made a massive visual change to the software.
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When displaying the tag database, the user can edit tags or monitor tags by selecting
the appropriate tab at the bottom of the display. The Edit tab allows users to create
new tags or modify existing tags (offline), while the Monitor tab allows users to
monitor or change the value of a tag.
There are also different filters available to limit the tags visible by type or by name. The
filter by name is not available on all revisions of RSLogix / Studio 5000.
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Output Window
For errors or
searching you
can click (or
double click) on
the line to go
directly to the
location.

The Output Window has three tabs at the bottom for Errors, Search Results and
Watch.

This window allows you to view and identify the following:

Errors
This tab displays the result of the last operation performed, and any errors that
occurred. Learn to check this carefully. Just because you told the system to perform a
download does not mean it was successful!

Search
This tab lists the results of the last search operation performed. If you have performed
a “Find All”; you may have to use the scroll bars to view all the results.

Watch
This tab may be used two ways:
• To view all the tags in the current routine or
• To create a custom list of the tags to monitor. The watch cannot be saved with
software versions below 18.
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Short Cut Key Strokes
Delete
Enter
Esc
Right or Left arrow

Space
Tab
Up or Down arrow
F1
F2
F3
F4

F6
Alt + ¯
Alt + F
Alt + E
Alt + V
Alt + S
Alt + L
Alt + C
Alt + T
Alt + W
Alt + H
Alt + Enter
Alt + Insert
Alt + Tab
Alt + Alt + Space
Alt + Drag1
Alt + 0
Alt + 1
34

Delete the character after the caret
Edit the current field
Cancel the current action, including a mouse drag
Open or close the current folder (+ or - folder toggle) in the
Controller organizer, or navigate to the left or right in the
various editors or browsers
Display context-sensitive menus (same as a right mouse click)
in the Controller Organizer
Advance the cursor forward through a dialog’s fields or buttons
Navigate up and down in the various editors or browsers
Help – Context sensitive
Edit the current field
Find the next search result
Navigate to the next error in the Output window's error list. A
useful trick is to hide the Output window, to reclaim the screen
real estate it takes, and to use F4 to navigate through the
errors.
Toggle between ladder editor panes
Access drop-down browsers or editors
Locate the cursor on the File option on the main menu
Locate the cursor on the Edit option on the main menu
Locate the cursor on the View option on the main menu
Locate the cursor on the Search option on the main menu
Locate the cursor on the Logic option on the main menu
Locate the cursor on the Communications option on the main
menu
Locate the cursor on the Tools option on the main menu
Locate the cursor on the Window option on the main menu
Locate the cursor on the Help option on the main menu
Display the properties for the active routine
Display the appropriate Add Language Element dialog
Switch between all running applications
Accesses the Control menu for a child window from which you
can move or resize the dialog
Accesses the Logix Designer application's Control menu
move a copy of the value to another field or a copy of an object
in the Controller Organizer
Toggle the Controller Organizer window
Toggle the Output window
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Alt + F4
Ctrl + Enter
Ctrl + PageDown
Ctrl + PageUp
Ctrl + Tab
Ctrl + Drag1
Ctrl + C
Ctrl + D
Ctrl + E
Ctrl + F
Ctrl + G
Ctrl + H
Ctrl + I
Ctrl + N
Ctrl + O
Ctrl + P
Ctrl + R
Ctrl + S
Ctrl + T
Ctrl + V
Ctrl + W
Ctrl + X
Ctrl + Y
Ctrl + Z
Ctrl + F4
Ctrl + F6
Shift + Tab
Shift + F3
Shift + F4

Shift + F10
Shift + Ctrl + Tab

Close the application in focus
Apply modifications to element comment in the Ladder Editor
and the tag description in the Tag Editor
Move to the next tab in a dialog or routine window
Move to the previous tab in a dialog or routine window
Move between multiple views (for example, Ladder Editor, Tag
Editor)
Move a copy of the value, or of an object in the Controller
Organizer, to another field
Perform a copy
Edit a description
Navigate to cross reference
Display the Find dialog
Display the Go To dialog
Display the Replace dialog
Toggle between insert and append modes
Create a new controller
Open a controller
Access the Print dialog
Insert a rung
Save a controller
Toggle the bit
Perform a paste
Access the New Tag dialog, from which you can add a new tag
Cut
Redo
Undo
Close window with focus
Toggle between multiple views (for example, Ladder Editor, Tag
Editor)
Move the cursor backward through a dialog’s fields or buttons
Find the previous search result
Navigate to the location in which the previous error occurred in
the ladder, or navigate to the previous error in the Output
window's error list
Display context-sensitive menus (this is the same as a right
mouse click)
Move between multiple views in the opposite direction from
Ctrl+Tab
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Your Turn
1) Start RSLogix 5000 and spend a few moments exploring each of the pull-down
menus. Familiarize yourself with the contents of each.
2) From the view menu, select toolbars, experiment turning various toolbars on
and off. Note the command button to set the toolbars back to the default state.
3) From View menu, select toolbars and then the Restore Factory Toolbar layout,
then enable the Bookmark toolbar.
4) From the Tools menu, select options and explore the various options that can
be modified. NOTE that you can change the default text size for the editors as
well as the colors. The number of backups and save time interval is also
adjustable. There is a reset for each category.
5) Create a new project; name it <yourname>_"todaysdate": Tom_Aug_1
a) Configure the processor model number, slot location and chassis size to
match your student demo unit and save your work.
6) Use File, Save As to save your file with the L5K extension.
a) Launch Windows Explorer and open the default folder.
b) Check the file size of the two versions of the project; the L5K file should be
much smaller.
c) Close Explorer.
7) Using the Help menu, identify which versions of RSLogix 5000 software are
installed on your computer. List them here:
__________________________________________________________
8) Open the project named “Project_1” from the support files. Answer the
following questions:
a) What model CPU is used? __________________________________
b) What slot is it located in? __________________________________
c) What size chassis is used? __________________________________
d) What firmware version is it? ________________________________
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RSLinx

Lesson Objectives
After the completion of this lesson, you will be able to:
❑ Configure the DF1 Driver
❑ Configure the Ethernet driver
❑ Configure the EtherNet/IP driver

Terminology
Driver

A small sub program defining the configurations settings required
for a software program running on a computer to talk to a controller
via some network.
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RSLinx

What is RSLinx?
RSLinx is a software package that allows software on a computer to communicate with
hardware in the real world. It can be thought of as the “conduit” between software
and hardware. It is server software.
RSLinx provides the following services:
• RSLinx allows some software running on a computer . . .
• To talk via its drivers out some port of the computer . . .
• Via some network . . .
• Out to some hardware
The above statements are purposely ambiguous because RSLinx defines all the aspects
of communication. When configuring drivers you decide which port you want to use,
and which network.
RSLinx can be configured to communicate with a ControlLogix processor using the
following protocols:
• RS-232 Driver using a serial connection
• Ethernet or EtherNet/IP
• ControlNet
• DeviceNet
• Data Highway Plus
The serial connection will provide point-to-point connection directly to a processor. All
other network options must be routed through their respective communications
bridge modules.
RSLinx may be run as a service under Windows or as an application. When RSLogix
5000 needs to communicate, it will launch RSLinx automatically. RSLinx will run in the
background indicated by a small icon in the taskbar as shown below.

RSLinx running as a service in the taskbar
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RSLinx Drivers
With the RSLinx window in focus, selecting the Communications pull down menu gives
the user access to the RSWho and Configure Drivers features.
When RSWho is selected, a window launches; in the left pane all existing drivers will be
displayed. By expanding a driver in the left pane, nodes accessible on the associated
network will be displayed in the right hand pane.

Configured
Drivers

The Configure Drivers menu displays drivers that have previously been configured and
their status. The combo box at the top allows you to add additional drivers. If there is a
port conflict; then a driver can be stopped to release the port for other software to use
it. However, a driver must be started and running in order for any Allen Bradley
software use it.
Add New Drivers
Not all the
drivers listed
are used for
ControlLogix
since RSLinx
supports all
Allen-Bradley
products.

Reconfigure
Existing Drivers
Start and Stop
Drivers

You can add the same type of driver multiple times by giving it a different name and
parameters.
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RS-232 DF1 Devices Driver
This is almost the “universal driver”; communications may be established with almost
every Allen Bradley device using this driver. To set this up you need:
• An available serial port on your computer. If none is available you can use a USB
to serial port converter.
• A serial cable. With ControlLogix, use a 9 pin female to female null modem
cable.
With the communication cable connected, from the Communication menu, select
configure drivers, then select the RS-232 DF1 devices driver, and Add New. The
configuration screen shown below will appear. Click on the Auto-Configure command
button. The software will attempt to learn the required communication parameters.

If the auto configure is unsuccessful, one of the following is most likely the cause:
• The wrong cable has been used
• The cable is not plugged in
• The serial port computer is in use
• Note that not all USB to serial port converter are compatible with RSLinx.
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USB Driver
Rockwell has started to
eliminate RS-232 ports
on the CPUs and replace
them with USB ports.
The USB port may be
used for programming
and troubleshooting.
The first time you connect the PLC to your computer, the computer will automatically
load the required driver. You may have to confirm the installation of the driver.
After the computer driver is loaded, RSLinx will automatically add the required RSLinx
communication driver.
Once, the driver is configured, you should be able to perform an RSWho and view the
PLC on the USB connection.

USB Pass Through to EtherNet/IP
When connected to the USB port; you can pass through the CPU/backplane/local
Ethernet to access devices on Ethernet. This is must be configured before it will work.
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If the computer
driver for a USB
processor has
not been
installed, it may
take a few
minutes for the
driver to be
properly
installed /
loaded.

RSLinx

Pass Through to ControlNet
You may also pass through to a ControlNet network and set its browsing range:

Ethernet Drivers
Ethernet is the most common type of driver used. There are two types of Ethernet
drivers. The Ethernet driver is the older version that supports standard Ethernet
devices including EtherNet/IP. The EtherNet/IP driver is newer, has extra features and
supports only EtherNet/IP capable modules.

Ethernet Devices
Driver
The Ethernet driver can be
used to communicate with
either Ethernet or
EtherNet/IP modules. The
catch is you have to know
the IP address of the
modules to configure it.
This driver is handy if you
wish to communicate with
only select IP addresses.
There is a maximum of 64
stations per driver.
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EtherNet/IP
Driver
EtherNet/IP is a special
form of Ethernet used
for industrial
processes. The IP in
this case stands for
Industrial Protocol. For
our purposes, it is only
important to know that
it can “self- discover”
EtherNet/IP modules
on the network it is
browsing.
From the configure menu, select Browse Local Subnet and select the Ethernet port to
use in the list below.
NOTE: this ability was added in later versions of RSLinx; otherwise, it uses the Windows
default.

Virtual Backplane Driver
The virtual backplane driver allows communications to the USB port, SoftLogix or the
Studio 5000 Emulator.
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FactoryTalk Linx
As of version 31+ you can download using either RSLINX Classic, or FactoryTalk Linx. In
Studio 5000 you must select the software you wish to use.

The newer version of FactoryTalk Linx comes with a browser that allows you to
configure drivers separately from the FactoryTalk Studio software.
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Checking Communications
To verify that communications are working correctly open RSWho in the
Communications menu. Make sure the Autobrowse feature is checked, click on the
driver (the top part of the driver tree must be selected), and the driver icon will
animate while browsing for the configured devices.

Any drivers
being browsed
will not be able
to be stopped or
reconfigured.

Autobrowse

Communication
Fault

After a timeout, if RSLinx cannot establish communications the device will display a red
X on it. RSLinx also remembers devices that were once connected but may not be
available at the moment. You can continue to expand the driver tree to see the chassis
and modules.
Remember - If you cannot communicate with a PLC, it is not a problem with RSLogix
software - if you can view the PLC in RSWho, you can communicate with it in RSLogix.
The most likely causes of communication problems are:
DF1 Driver:
EtherNetIP Driver:
Ethernet Driver:

Wrong COM port or cable.
Incorrect network settings in Windows.
Incorrect network settings in Windows.
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EDS Files
As there is always new hardware or new versions of existing hardware released, it is
possible that RSLinx cannot identify a device in RSWho. RSLinx displays a device it
cannot identify with a yellow question mark.

The data required to identify new devices is stored in an EDS file (Electronic Data
Sheets). In some cases if the EDS file is for an earlier version of a module, the module
may be identified, but not fully functional within RSLinx.
EDS files can be downloaded from the AB web site. There is a utility program to
register them. The software can be accessed from the RSLinx tools menu. A similar tool
is available from within RSNetworx software.

Depending on the version of RSLinx on your computer and the device, you may also be
able to upload the EDS file directly from the device.

Right click on the device in RSLinx and
select "Upload EDS from Device". This
will launch the EDS registration tool and
register the EDS.

NOTE that you may have to register multiple EDS files for new hardware. For example,
the L23E CPU requires two EDS files, one for the Ethernet interface and one for the
CPU itself.
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Your Turn
1) Start RSLinx if it is not running.
2) If RSWho is active in RSLinx, close it.
3) Select the Configure Driver option from the Communication menu.
4) Delete any existing drivers.
5) Makes sure there is an Ethernet cable connected from the computer to the
Ethernet module.
a) Add the EtherNet/IP Driver.
b) Use RSWho to ensure that the EtherNet/IP driver is running. List the IP
addresses of the ControlLogix demos.
_______________________________________________________
_______________________________________________________
_______________________________________________________
_______________________________________________________
c) Add the Ethernet devices driver to RSLinx. Configure it with the IP address
of your demo station.
6) Optional – Depending on the equipment available, the instructor will let you
know whether to do this step or not.
a) Connect the serial communication cable included with the computer. You
will have to use a USB to serial converter. Remember to check which com
port the USB adapter is using. Do this by right clicking on the Computer in
the start menu and selecting properties and then Device Manager.
b) Add the RS-232 DF1 devices driver to RSLinx.
c) Set the Com Port to that assigned to the USB adapter, and then use the
Auto Configure button to configure the serial parameters. The RS-232 and
USB adapter must be plugged in for this to work.
d) Perform an “Auto-Configure” with the cable unplugged.
7) Add the virtual backplane driver. Set slot to 0”.
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Configuring Ethernet
Modules

Lesson Objectives
After the completion of this lesson, the student will:
❑ Configure an Ethernet module using RSLinx
❑ Configure an Ethernet module using BOOTP

Terminology
MAC

Media Access Control. A unique address assigned to hardware devices on
an Ethernet network.

DHCP

Short for Dynamic Host Configuration Protocol, a protocol for assigning
dynamic IP addresses to devices on a network. With dynamic addressing, a
device can have a different IP address every time it connects to the
network.

BootP

Bootstrap Protocol. A TCP/IP protocol used by nodes to obtain its IP
address, server address, default gateway, and other network information.

IP

An Internet Protocol address (IP address) is a numerical label assigned to
each device participating in a computer network. An IP address serves two
principal functions: host or network interface identification and location
addressing. The designers defined an IP address as a 32-bit number and
this system, known as Internet Protocol Version 4 (IPv4). However, due to
the enormous growth of the Internet and the predicted depletion of
available addresses, a new version of IP (IPv6), using 128 bits for the
address, was developed in 1995. IP addresses are binary numbers, but
they are usually stored in text files and displayed in human-readable
notations, such as 172.16.254.1 (for IPv4), and 2001:db8:0:1234:0:567:8:1
(for IPv6).

Subnet
Mask

The subnet mask is used to determine where the network number in an IP
address ends and the node number in an IP address starts.
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General
A brand new “factory fresh” Ethernet module does not have an IP address assigned to
it. The module must be configured or assigned an IP address using one of two
methods:
1) If there is an existing working path to the module, then RSLinx can be used to
configure it. This would be the case if the module was in a chassis with a CPU.
The RSLinx DF1 driver could then be used to assign the address.
2) If there is no valid path to the module, then a process called BOOTP or DHCP
could be used. Rockwell Automation provides a BOOTP server software with
the install of RSLogix 5000.

Configuring Through RSLinx
If a path exists to get to the module in RSLinx, either because there is another
communication module in the chassis, or because the module already has an IP
number, and all you wish to do is change it, the module may be accessed via RSLinx.
When configuring an Ethernet module with RSLinx, the module may appear in the
RSWho screen multiple times. Only the first occurrence of the module in a tree can be
used to configure the module. In the left diagram below, location A and B are the same
module. Only A can be used to configure the module. Right click on the module as
shown in the diagram below right and select module configuration.
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The configuration screen is shown to the
right. This one is for a 1756-ENET module.
The screen is similar for other EtherNet
modules.
As a minimum, you must set the IP address
and the Subnet Mask. These should be part
of your system documentation / electrical
prints for the machine. Depending on your
application, you may have to populate the
other data fields.
Once you have made the changes, click on
the Apply button. If you have changed the
IP or sub net mask, you may lose
communication to the module.

BootP/DHCP
If the module is in “out of the box” state and you cannot get access to the module
through some other communication path, the way to go is to use Bootp or DHCP.
Rockwell Automation includes a BootP/DHCP server with RSLogix 5000 software.
NOTE: A newer version of the utility has been renamed BOOTP-DCHP Tool.

All devices on Ethernet have a MAC address, each device is unique. So no two devices
should ever have the same MAC address. When BootP is being used, the module
broadcasts its MAC address to all stations (multicast) requesting that a server respond
with its IP address.
When a server receives the message; it looks up the MAC address to see if there is an
entry in its database indicating what IP address corresponds to the MAC address
broadcast. If there is an entry, the BootP server responds with a message instructing
the device what its IP address should be. The module will then use that IP until the
next time it is reset (cycle power), and then it will perform another BootP broadcast.
The DHCP process is similar. In this process, however, the MAC address is not used to
assign the IP address. The module will broadcast a message requesting the DHCP
server which will respond with the next available IP address from a list. The next time
this same module boots up using DHCP, it could receive a different address from the
server.
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The screen capture below shows the BootP / DHCP server receiving requests. It
displays the time, the type and the MAC address.

The relationship between the MAC address and the IP address has to be configured.
This can be done by left clicking on the New button in the Relationship list or by double
clicking on the device in the Request History window.
The screen below shows the dialog box that appears by double clicking on the device in
the request history window. In this example, we are setting 172.168.1.205 to MAC
address 00:00:BC:03:C9:6D.
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After clicking on OK, the next
time the module does a BootP
request, the server will respond
with the configured IP address.
See the next screen capture.

The BootP server software must be configured
with the subnet mask. If a Gateway, DNS and
Domain name are being used they must also be
configured. This is done by selecting Network
Settings from the Tools menu. The first time
the software is run, this dialog box will
automatically appear.

Now that the Ethernet module has an IP
address, you may want to disable the
BootP utility in the module. If the module
experiences a power cycle with BootP
enabled and the BootP software is not
running, the module will not get an IP
address. To prevent this, make the IP
address static by disabling the BootP
utility. This may be done in RSLinx
(preferred) or in the Bootp Utility.
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Your Turn #1 – Changing the IP
1) Using RSLinx, change the IP address of the Ethernet module in your demo to be
10 higher than it is currently. Check to be sure this does not result in an IP
address conflict with another station.
2) Using RSLinx set the IP address back at its original address.
Remember – If you are using the Ethernet driver in RSLinx, you will have to
configure another entry in the driver to allow you to communicate to the
module after you have changed its IP address. If you are using the DF1 or
EtherNet/IP driver you will not have to make any changes to the driver.

Your Turn #2 - Using DHCP (Optional)
1) Use RSLinx to change the IP configuration of the PLC communication module to
Bootp. Note the IP address of the unit: ________________
2) Start the Bootp software on your computer.
3) Cycle power to the PLC demo, if you have an ENBT module, note the messages
on the LED display. If you have an EN2T you will not need to cycle power.
4) Note the BootP message in the server software, double click on it and assign
the IP address to what you wrote down in #1.
5) The device should receive its IP address, use RSLinx to confirm it is correct and
set the device back to Static.
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CPU Modes

Lesson Objectives
After the completion of this lesson, the student will:
❑ Understand the operation modes available with the ControlLogix CPU
❑ Be able to change the mode of the CPU using either the key switch or RSLogix
5000 software
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CPU Modes

Processor Operating Modes
The key-switch on the ControlLogix processor has three positions.

RUN
In the Run position, the processor is actively controlling the
machine/process. Online editing and downloads are not possible.

PROG (Program)
In the Program position, the processor does not scan the project.
Input cards continue to write status to the processor. The
machine/process is dormant.
Warning: Selecting Program mode does not guarantee that outputs
will turn off. The state outputs enter when program mode is
selected depends on the various card configurations.

REM (Remote)
By setting the key-switch in the Remote position, the processor operating mode can be
changed via a programming terminal. Modes available are Remote Run, Remote
Program and Remote Test mode.
Remote Test is used strictly for program debugging. The processor behaves as though
it is in Remote Run mode, but all of the real world outputs are deactivated. Test mode
may only be entered using RSLogix 5000 software.
There is a level of security provided by the key switch. When either Run or Program
Mode is selected, selecting the appropriate mode and simply removing the key will
inhibit others from inadvertently changing modes. Although it must be understood,
that this by no means replaces any plant wide lockout procedure. Not only are the keys
plentiful, and identical for every ControlLogix system, but they are also the same keys
used in the SLC500 product line.
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Online Toolbar
The Remote key-switch position allows the user to remotely switch between run and
program via their computer. This functionality is provided by the online toolbar, once
online, located near the top left of the RSLogix 5000 session.

This graphic shows:
• The green highlight next to Rem Run shows that the processor is in Remote Run
mode
• The green box to the left of the word Running says the program is running
• The green box next to the Controller OK text shows that there are no faults in
the processor
• The grey box, or more accurately the lack of a red box next to the Battery OK
text says that the battery is healthy
• The green box next to the I/O OK indicates that the processor is communicating
with all of the configured I/O. If I/O was missing this indicator would be
flashing green.
Other indicators on the Online Toolbar include:
• Force Information: Always check for the presence of forces in a project.
• Edits Information: If there is an online edit in the processor this indicator will
advise if the edit is disabled or being tested.

© Automation Training - 2021

57

CPU Modes
There is a pull-down arrow in the green box next to Rem Run. Clicking the pull down
arrow displays the following:

Selecting Program Mode places the processor in Remote Program mode.
Once in Remote Program the pulldown dialog box shows the following:

Notice the aqua colour and the text Rem Prog, indicating the processor is in Remote
Program mode. Selecting Run Mode will place the processor into Remote Run mode.
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ControlLogix

Downloading / Uploading

Lesson Objectives
After the completion of this lesson, the student will be able to:
❑ Download a project to a CPU
❑ Upload a project from a CPU

Terminology
Upload

Transferring a project file from a CPU to RSLogix 5000.

Download

Transferring a project file from RSLogix 5000 to a CPU.

Online

RSLogix 5000 is displaying program and data information in the
CPU.

Offline

RSLogix 5000 is displaying program and data stored in the
computer.

AB_CLX_Downloading_Uploading_4D.docx

Downloading/Uploading

Downloading
Downloading a project will overwrite the current contents of the CPU (program and
data). Be certain you are downloading the correct project to the correct processor. A
good practice is to always use Communications > Who Active to verify the correct
path.
To download to a processor:
1) A driver in RSLinx must exist or be configured that provides a valid path to the
processor.
2) The project’s CPU type and firmware version must match the hardware and
there are no errors in the program.
3) The path stored with the project must be correct. If it is incorrect or the path is
set <none>, then the path must be manually selected. The path is set with the
Who Active dialog box located under the Communication menu. You can then
set the path and resave the project or leave it as <none>.

4) The download may be initiated from a number of locations:
a) From the Communication menu
b) From the Online Toolbar
c) From the Who Active screen
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Downloading/Uploading

If the offline project matches the online project then
just Go Online. You do not need to Download or Upload.

Uploading
Uploading is the transfer of the program and data from the processor to RSLogix 5000
software and potentially the hard drive of the computer. You will have to perform an
upload when:
1) There is no project for the processor stored on the computer or RSLogix 5000
software cannot locate it.
2) The project on the computer does not match the project in the processor. This
could have been caused by someone performing an online edit and not
updating the saved copy of the program.
When you upload the project, there will be no rung comments or descriptors; these
are stored in the offline project.
Access to the uploading function is the same as it is for downloading:
• From the Communication menu
• From the Online Toolbar
• From the Who Active screen
One difference, between uploading and downloading is you do not have to have a
project open when you perform an upload. Use the RSWho function and browse to the
processor you wish to upload or go online to.
NOTE: if the CPU name matches an existing project file name in the project folder then
RSLogix 5000 will automatically upload to that project.
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Downloading/Uploading

Your Turn #1
1) Copy the ACD file with the same name as the CPU in your demo
(Download_L63, Download_L73, etc.) from the USB stick “\supportFiles” sub
directory to “c:\RSL5000\Project”. The student files are also located on the
computer in the Documents\1_Student_USB\CLX_M1_4 sub directory.
2) Open the project.
3) Note that there is no path set in the project.
4) Set the path to match the demo station. Confirm that the correct path is set.
5) Download the project to the demo station and place the processor into the run
mode.
6) The I/O panel lights on the bottom of the demo should flash sequentially.

Your Turn #2 - Optional
1) If you have a project open in RSLogix 5000, close it.
2) Using Windows Explorer, delete the project Download_??
3) Upload the project from the ControlLogix demo station and then go online to it.
4) While online, save your work.
5) Finally close the RSLogix 5000 project and delete it from the hard drive.

Your Turn #3
1) Download the file you made in a previous lesson ie. Sean_May1.Acd
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